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About This Manual 
Congratulations on your purchase of the NCSS statistical package! The NCSS statistical package 
offers: 

• Easy data entry. 

• Statistical routines that provide high quality and accuracy yet are quick and easy to learn 
and use. 

• Straightforward procedures for creating paper printouts and file copies of both the results 
of the statistical analyses and graphical representations of those results. 

Our goal is that with the help of this NCSS Quick Start booklet, you will be up and running on 
the system in less than one hour. Specifically, you will quickly and successfully complete the 
following tasks: 

• Enter a small set of data into NCSS (that is, create a database), label the variables, and 
print a hard copy of your data. 

• Compute descriptive statistics on the data in the database that you created.  Run a T-test 
and a regression analysis on your data. 

• Print copies of the descriptive statistics reports and the other reports which you generate.  
Print graphical representations of those analyses.  Export your text and graphic material 
to a word processing program such as Microsoft Word. 

We believe you will find that this NCSS Quick Start booklet provides a quick, easy, efficient, 
and effective way for first-time NCSS users to get up and running. NCSS users needing details on 
how to execute particular tasks should find the self-help chapters in the second half of this 
booklet very useful.   

I look forward to any suggestions you have to improve the usefulness of this manual and/or the 
NCSS system. Meanwhile, good computing! 

 
       Jerry Hintze, President 
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Chapter 1 

Installation and 
Basics 
Before You Install 

1. Check System Requirements 
NCSS runs on 32-bit and 64-bit Windows systems. This includes Windows ME, Windows NT 
4.0, Windows 2000, Windows XP, and Windows Vista. The recommended minimum system is a 
Windows XP or Vista-compatible PC.   

NCSS takes up about 120 MB of disk space. Once installed, NCSS also requires about 20 MB of 
temporary disk space while it is running.  

2. Find a Home for NCSS 
Before you start installing, decide on a directory where you want to install NCSS. By default, the 
setup program will install NCSS in the C:\Program Files\NCSS\NCSS 2007 directory. You may 
change this during the installation, but not after. The example data, template, and macro files will 
be placed in your personal documents folder (usually C:\…\[My] Documents\NCSS\NCSS 2007) 
in appropriate subdirectories. The program will save all procedure templates and macros to these 
folders while the program is running. 

3. If You Already Own NCSS 
If NCSS is already installed on your system, instruct the installation program to place this new 
version in a new folder (e.g. C:\Program Files\NCSS\NCSS 2007). All appropriate files will be 
copied from your old NCSS directory or replaced by updated files. 

What Install Does 
The installation procedure creates the necessary folders and copies the NCSS program from the 
installation file, called NCSS2007SETUP.EXE, to those folders. The files in 
NCSS2007SETUP.EXE are compressed, so the installation program decompresses these files as it 
copies them to your hard disk.  

The following folders are created during installation: 

C:\Program Files\NCSS\NCSS 2007 (or your substitute folder) contains most of the program 
files. 
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C:\Program Files\NCSS\NCSS 2007\Pdf contains printable copies of the documentation in PDF 
format.  

C:\Program Files\NCSS\NCSS 2007\Sts contains all labels, text, and online messages.  

C:\…\[My] Documents\NCSS\NCSS 2007\Data contains the database files used by the tutorials. 
We recommend creating a sub-folder of this folder to contain the data for each project you work 
on. An empty subfolder called “My Data” is created within this folder for easy storage of your 
personal data files. You can save the data to any folder you wish. 

C:\…\[My] Documents\NCSS\NCSS 2007\Junk contains temporary files used by the program 
while it is running. Under normal operation, NCSS will automatically delete temporary files. 
After finishing NCSS, you can delete any files left in this folder (but not the folder itself). 

C:\…\[My] Documents\NCSS\NCSS 2007\Macros contains saved macros.  

C:\…\[My] Documents\NCSS\NCSS 2007\Report is the default folder in which to save your 
output. You can save the reports to any folder you wish. 

C:\…\[My] Documents\NCSS\NCSS 2007\Settings contains the files used to store your template 
files. These files are used by the NCSS template system, which is described in a later chapter. 

Installing NCSS 
This section gives instructions for installing NCSS on your computer system. You must use the 
NCSS setup program to install NCSS. The files are compressed, so you cannot simply copy the files 
to your hard drive. 

Follow these basic steps to install NCSS on your computer system. 

Step Notes  

1. Make sure that you are using a 32- or 64-bit version of windows such as Windows Me, 
Windows NT 4.0, Windows 2000, Windows XP, or Windows Vista. 

2. If you are installing from a CD, insert the CD in the CD drive. The installation program 
should start automatically. If it does not, on the Start menu, select the Run command. 
Enter D:\NCSS\NCSS2007Setup. You may have to substitute the appropriate letter for 
your CD drive if it is not D. If you are installing from a download, simply run the 
downloaded file (NCSS2007Setup.exe). 

3. Once the setup starts, follow the instructions on the screen. NCSS will be installed in the 
drive and folder you designate. 

If Something Goes Wrong During Installation 
The installation procedure is automatic. If something goes wrong during installation, delete the 
C:\Program Files\NCSS\NCSS 2007 directory and start the installation process at the beginning. 
If trouble persists, contact our technical support staff as indicated below. 

Starting NCSS 
NCSS may be started using your keyboard or your mouse using the same techniques that you use 
to start any other Windows application. You can start NCSS by selecting NCSS 2007 from your 
Start menu using standard mouse or keyboard operations. 
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Entering Your Serial Number 
The first time you run NCSS, enter your serial number in the appropriate box in the pop-up 
window that appears. If you do not enter a serial number, NCSS will enter trial mode and you will 
have 7 days to evaluate NCSS. When in trial mode, NCSS is fully-functional but is limited to 100 
rows of data. 

 

 

Enter your NCSS serial 
number here. 

 

When you click OK, the NCSS Data window will appear. If you entered a serial number, you 
must quit and restart the program for the serial number to take effect. 
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The Three Main NCSS Windows 
NCSS is controlled by three main windows:  

1. Data Window 

2. Procedure Window 

3. Output Window 

Each window has its own menu bar and tool bar. We will now briefly describe each of the three. 

The NCSS Data Window 
The NCSS Data window contains the data that is currently being analyzed. This window lets you 
view, modify, and save your data. It has the look and feel of a spreadsheet. This is the main NCSS 
window. Closing this window will exit NCSS. 

Chapter 7 provides a closer look at the Data window. 
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The NCSS Procedure Window 
The NCSS Procedure windows let you set the options for a particular analysis. Whether you are 
running a multiple regression, an ANOVA, or a scatter plot, you will set the options of this 
procedure in the Procedure window. Closing this window will not exit NCSS. 

Chapter 8 provides a closer look at the Procedure window. 
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The NCSS Output Window 
The NCSS Output window displays the output from the statistical and graphics procedures. It 
serves as a mini-word processor --- allowing you to view, edit, save, and print your output. 
Closing this window will not exit NCSS. 

Chapter 9 takes a closer look at the Output window. 
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Moving from Window to Window 
There are several ways of moving among the windows:  

1. Remove the windows you are not currently using by minimizing them. 

2. Arrange the windows on your screen so that all can be seen. 

3. Use the task bar along the bottom of your screen. 

4. Use the Windows menu. 

5. Use the Navigator. 

6. Use the toolbar (this is usually the quickest and easiest). 

Selecting a Procedure 
There are three primary ways to select a procedure:  

1. Select the procedure from the Analysis or Graphics menu 
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2. Click the button of the corresponding procedure from the Quick Launch 
buttons or from the quick access buttons of the tool bar 

 
Click on the Quick Launch button 
from the tool bar. 

The Quick Launch window will open. 

 

 

 

 

 

 

 

 
Find the desired procedure and 
click the corresponding button. 

 

 

 

 

 

 

 

 

 

 

Buttons for the most commonly 
used procedures may be added 
to the tool bar by dragging and 
dropping them to the tool bar. 

Eight procedure buttons are 
available on the tool bar. 

The procedure of the tool bar 
buttons may also be changed by 
right-clicking on one of the eight 
buttons of the tool bar and 
selecting the desired procedure. 
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3. Select the procedure using the Navigator 
 

 
Click on the Navigator 
button from the tool bar. 

The Navigator window will 
open. 

 

 

 

 

 

 

 
Click to the left of a category 
to open the category. 

 

Continue until the desired 
procedure is reached. 

 

Double-click on the 
procedure name or symbol to 
open it. 
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Obtaining Help 

Help System 
To help you learn and use NCSS efficiently, the material in this manual is included in the NCSS 
Help System. The Help System is started from the Help menu or by clicking on the yellow '?' icon 
on the right side of the toolbar. NCSS updates, available for download at www.ncss.com, may 
contain adjustments or improvements of the NCSS Help System. Adobe Acrobat or Adobe 
Reader version 7 or 8 is required to view the help system. You can download Adobe Reader 8 for 
free by going to www.adobe.com. Adobe Reader 8 can also be installed from the Utilities folder 
on your NCSS installation CD. 

 

 
 

http://www.ncss.com/
http://www.adobe.com/
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Navigating the Help System 
There are a few key features of our help system that will let you use the help system more 
efficiently. We will now explain each of these features. 

Index Window 
The Index Window can be launched at any time by clicking on the Index button on the NCSS 
Help System display window. The index allows you to quickly locate keywords and/or statistical 
topics. You can narrow the list of index entries displayed by selecting a specific topic category in 
the uppermost dropdown box. 

 

 
 

Index entries are displayed in the format  

Index Entry --- CHAPTER NAME    or     CHAPTER NAME --- Index Entry. 

 

You can control which entries are displayed by clicking on the radio buttons at the bottom of the 
window. 
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Contents Window 
Clicking on the Contents button opens the Contents (Bookmarks) Window of the viewer. From 
this window you can expand the table of contents to view nested headings. You can click on the 
“Expand Current Bookmark” icon to instantly find the bookmark location for the currently-
displayed page in the help document. 
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Search Window 
Clicking on the Search button opens the Search Window of the viewer. From this window you 
can search the entire help system for any word or phrase. A search can also be initiated from the 
Find box in the viewer toolbar. 
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Printing the Documentation 
To print pages from the documentation, click on the Print button on the NCSS Help System 
toolbar. This will launch the Adobe Reader print dialogue screen. You can choose to print a 
single page or a range of pages from the help file. When entering page numbers, remember to use 
the PDF file page numbers (e.g., 750-756) and not the page numbers found in the document pages 
(e.g., 212-4 to 212-10 is not a valid page range). The Adobe Reader page numbers can be seen in 
the viewer window. 
 

 
 

If you are using Adobe Reader 7, then the page numbers are found at the bottom of the viewer 
window. 

One of the benefits of the NCSS Help System is the ease with which you can print any chapter or 
topic from the electronic help manual. To print a single chapter or topic using your default PDF 
viewer, take the following steps: 

1. Click on the Chapter PDF icon in the NCSS Help System toolbar.  

 
 

2. Choose the chapter you would like to print from the list and click Load Chapter PDF. 
This will launch the individual chapter PDF in a separate window using your default PDF 
viewer (e.g., Adobe Reader). 
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3. Use the Print function of your PDF viewer to print the entire chapter or individual pages 
from the chapter. 

If you have Adobe Reader 8 or later, you can print entire chapters using an alternative method as 
follows (This will not work with Adobe Reader 7): 

1. Open the Contents (Bookmarks) Window by clicking on the Contents button at the top 
of the NCSS Help System display window. 

 
 

2. Expand the bookmarks to display the chapter or topic name you wish to print (e.g., the 
Two-Sample T-Test Chapter). Then, highlight the chapter name, right-click on the 
highlighted selection (or select Options in the panel above), and select Print Page(s). 
This will automatically print only the pages from the selected chapter. 

CAUTION: When you click Print Page(s), the command is sent to the printer 
automatically without any intermediate Print Setup window being displayed. Make sure 
that you have selected only the topic you want before clicking Print Page(s). 

 

 
 

If you do not want to print the entire chapter, continue to expand the bookmark tree to the 
topic you wish to print before completing step 2. The Print Page(s) command prints all 
pages containing bookmarks that are nested within the highlighted bookmark.  
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Technical Support 
If you have a question about NCSS, you should first look to the printed documentation and the 
included Help system. If you cannot find the answer there, look for help on the web at 
www.ncss.com/support.html. If you are unable to find the answer to your question by these 
means, contact NCSS technical support for assistance by calling (801) 546-0445 between 8 a.m. 
and 5 p.m. (MST). You can contact us by email at support@ncss.com or by fax at (801) 546-
3907. Our technical support staff will help you with your question. 

If you encounter problems or errors while using NCSS, please view our list of recent corrections 
before calling by going to www.ncss.com/release_notes.html to find out if you problem or error 
has been corrected by an update. You can download updates anytime by going to 
http://www.ncss.com/download.html. If updating your software does not correct the problem, 
contact us by phone or email. 

To help us answer your questions more accurately, we may need to know about your computer 
system. Please have pertinent information about your computer and operating system available. 

 

http://www.ncss.com/support.html
mailto:support@ncss.com
http://www.ncss.com/release_notes.html
http://www.ncss.com/download.html#Updates
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Chapter 2 

Creating / Loading 
a Database 
About This Chapter (Time: 21 minutes) 
This chapter will show you how to enter, label, save, and print a database. You will find complete 
coverage of these subjects in NCSS User's Guide I.  

Starting NCSS 
Select All Programs > NCSS from the Windows Start menu to start NCSS. After starting, the 
NCSS spreadsheet program appears with an empty datasheet. We will begin by entering data into 
this datasheet. 
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Brain Weight Data 
The following data give the body weight in kilograms and the brain weight in grams of various 
mammals. This chapter will show how to enter these data into an NCSS database and perform 
basic database operations such as saving and printing. 

Mammal Body Brain 
Name Weight Weight 
African Elephant 6654 5712 
Asian Elephant 2547 4603 
Giraffe 529 680 
Horse 521 655 
Cow 465 423 
Gorilla 207 406 
Pig 192 180 
Jaguar 100 157 
Man 62 1320 
Chimpanzee 52 440 
Gray Wolf 36 120 
Kangaroo 35 56 
Baboon 11 179 
Red Fox 4 50 
Cat 3 26 

Entering a Column of Data 
Take the following steps to enter the brain weight data into NCSS: 
 
 

 
 

 

 
1. Position the cursor in the upper-left 

cell. This is done by clicking in the 
cell just below the title C1. 
 
 
 

 
 
 

2. Type African Elephant. Notice that 
as you type, the characters appear 
in two places: in the cell where you 
are typing and in the cell-edit box at 
the top of the sheet. 
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3. Press Enter. The text is entered and 

the cell cursor (the dark border 
around the cell) moves down to the 
next cell. 

 
 
 
 
 
4. Type Asian Elephant. 

Press Enter. 
Type Giraffe. 
 
Continue until you finish entering all 
of the names. 

 
 
 
 
5. Using the vertical scroll bar or the 

Page Up key, reposition the screen 
so that you can begin entering data 
in the second column. Click in the 
first row of column two. This will 
highlight this cell. 

 
 
 
 
6. Type in the second and third 

columns of numbers. The completed 
table should appear as shown. 

 

 
 

 
 

 

 

To cancel an entry, you can press 
the Esc key. If you have already 
pressed Enter, you can choose 
Undo from the Edit menu. 
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Labeling a Variable 
In NCSS, a column of data is called a variable. Each variable has a column number and a name. 
The name is the label at the top of the column. The name of the variable will be displayed in all 
statistical reports and graphs that you generate, so it is important to name variables so that they 
will be remembered.  

In a new database, the variables receive the default names C1, C2, C3, etc. Hence, you have just 
entered data into variables C1, C2, and C3. We will now show you how to change the names of 
these variables. 

 

 
1. Click on the Variable Info tab. 
 
 
 
 
 
 
 
 
 
2. Click in the C1 cell. This will position 

the cell cursor in that cell. (The cell 
cursor may already be there.) 

 
 
 
 
 
3. Type Name. 
 Press Enter. 
 Type Body_Weight. 
 (Use the underscore, not the minus 

sign in these names.) 
 Press Enter. 
 Type Brain_Weight. 
 Press Enter. 
 
 
4. Click on the Sheet1 tab. This will 

return you to a view of the data. The 
screen should appear like this. 

 
 

 
 

 
 

 

 
 
 
 
 
 



  Quick Start – Creating / Loading a Database  2-5 

The final step is to widen the columns so that the complete names and labels are shown. 

  
 

 
 

 
 

 
 

5. Drag the mouse from the Name 
heading to the Brain_Weight 
heading. This is done by pressing 
the left mouse on the heading Name 
and, without letting up, moving the 
mouse pointer to the heading 
Brain_Weight and finally letting up 
on the mouse. All three columns 
(headings and data) will be 
darkened. 

 
 
6. Now, position the mouse between 

the two columns. The mouse pointer 
will change to a two directional 
arrow. 

 
 
 
 
 
 
7. Drag the mouse to the right until you 

are almost to the next border and let 
go of the mouse button. The 
columns will be widened, showing 
the complete variable names 
(column headings) and animal 
names. 

 
 
 
8. Click on a cell in the body of the 

table to cancel the selection (the 
reverse video). 

 
 

 

 

Variable names are used throughout the program to identify which columns of data to 
analyze. A variable name must begin with a letter (not a number); should contain only 
letters, numbers, and the underscore; and should not contain blanks. For correct 
formatting on reports, variable names should be less than fourteen characters, although 
there is no maximum length.  
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Saving Your Database 
As you enter data, it is stored in your computer’s temporary memory but not on your hard disk. If 
the computer loses power, you lose your data. We will now show you how to save the data  to 
your hard disk.  

 

 
1. Select Save As from the File menu 

of the Data window. 
 
 
 
 
 
 
 
 
 

 
2. Select the DATA directory in your 

NCSS directory. 
 
 
3. Enter mydata.s0 in the File Name 

box. 
 
 
 
4. Click Save button.  

 
 

The database is stored as two files 
on your hard disk. If you use 
Windows Explorer to view the Data 
directory, you will find that you have 
created two files: mydata.s0 and 
mydata.s1. The name of the 
database is now displayed at the top of the data window. 

 
 

 
 

 

 

An NCSS database name must end with the file extension “.s0”. Hence, a valid file name 
would have numbers, spaces, and letters followed by the extension “.s0”. For example, 
you might use “abc.s0”. 
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Printing Your Database 
You will often want to create a printout of the data you have entered. We will now show you how 
this is accomplished.  

 
1. Select Data Report from the Data 

menu. The Data Report procedure 
appears. This window allows you to 
control the format of your report. 
 

  
2. Click on the button to the right of 

the Data Variables line. 
 
 
 
 
3. Select the first three variable 

names: Name, Body_Weight, and 
Brain_Weight. 
Press Ok. 
 
These variable names will appear in 
the Data Variables box. 

 

 
 
 
 
 
 

  
4. Enter 2.0 in the First box of the 

Tabs section. 
 
 
 
 
 
5. Press the Run button on the left of 

the toolbar at the top of the window. 

 
 

 
 

 
 

 
 

 
 

 
 
 
 
 



2-8  Quick Start – Creating / Loading a Database  

The report will appear as shown below. 
 

 
Data List Section 
    
Row Name Body_Weight Brain_Weight 
1 African Elephant 6654 5712 
2 Asian Elephant 2547 4603 
3 Giraffe 529 680 
4 Horse 521 655 
5 Cow 465 423 
6 Gorilla 207 406 
7 Pig 192 180 
8 Jaguar 100 157 
9 Man 62 1320 
10 Chimpanzee 52 440 
11 Gray Wolf 36 120 
12 Kangaroo 35 56 
13 Baboon 11 179 
14 Red Fox 4 50 
15 Cat 3 26 
 

 
  
6. Finally, select Print from the File menu of the 

Output window. This will display the Print 
dialog box from which you can print the 
report. Or, highlight the text using the mouse, 
and cut and paste the report directly into a 
word processor or slide show. 

 
 

 

 

 

 

 

 

Congratulations! You have successfully entered and printed a set of statistical data. Analyzing 
these data using the various statistical procedures will not be much more difficult. 
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Clearing the Database 
As you move from analysis to analysis, you will often have to clear the data screen so that new 
data may be entered. This is done as follows. (Of course, you should save your data before 
clearing it!)  

 
1. Select New from the File menu of 

the Data window. Use the Windows 
menu to transfer from the Output 
window to the Data window. If you 
have not previously saved your 
data, choosing New will cause the 
program to ask you if you want to 
save the current datasheet before it 
is cleared. 
 
 
 
 
 
 
  

 
  
2. Click OK. This will clear the screen 

and present you with an empty file 
just like when you start the 
program. 

 
 
 
 

 

NCSS maintains two data formats. The spreadsheet (S0-type) format is for routine 
databases of fewer than 16,384 rows and 256 columns. The database (S0Z-type) format 
is for databases with more than 16,384 rows and/or 256 columns. 
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Loading a Database 
Take the following steps to load the brain weight data into NCSS:  
 
 
1. Select Open from the File menu of 

the Data window. The File Open 
window will appear. 
 
 
 
 

2. Double click the Data subdirectory 
to select it. 

 
3. Double click MAMMALS.S0 in the 

list of available files. 
 
4. Click the Open button. 
 
 

This will load the MAMMALS 
database into the Data window. 
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Chapter 3 Chapter 3 

Data 
Transformation 
Data 
Transformation 
About This Chapter (Time: 13 minutes) About This Chapter (Time: 13 minutes) 
This chapter continues the introduction to the NCSS system by taking you through examples of 
using transformations to create new variables. Specifically, you will be shown how to calculate 
percentages and how to recode the values of a variable.  

Loading the MAMMALS Database 
Take the following steps to load the brain weight data into NCSS: 
 
 
1. Select Open from the File menu of 

the Data window. The File Open 
window will appear. 

 
 
 
 
 

2. Double click the Data subdirectory 
to select it. 

 
3. Double click MAMMALS.S0 in the 

list of available files. 
 
4. Click the Open button. 
 
 

This will load the MAMMALS 
database into the Data window. 
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Creating a Percentage Variable 
 
1. Click on the Variable Info tab. This will 

position you in the Variable Info 
datasheet. 
 
 
 
 
 
 
 
 
 

2. In the Transformation column, click on 
the fourth cell down--the one in the C4 
row. This will position the spreadsheet 
cursor in this cell. This is where the 
transformation will be entered. 
 
 
 
 
 

3. Type in the transformation expression: 
Brain_Weight/Body_Weight/10.  
(Be sure to type the underscores!) 

 Press Enter. 

Notice that you edit the transformation in 
the edit bar at the top of the 
spreadsheet. 

This step enters the new transformation 
expression, but does not change the 
data. The data are not generated until 
the spreadsheet is manually 
recalculated. 
 
 

4. Click on C4 in the Name column and 
type Percent and press Enter. 

This renames the variable from the 
default of C4 to a new value that better 
describes the data in this column. 
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5. Double click on the cell in the fourth  
row in the Format column. 
 
This will display the Format window  
for editing the format of the Percent  
variable. Note that this format will 
not influence the internal precision 
of the data. 

 

 

 
6. Select the two-decimal format: 

0.00 from the list. 
 
Although it is not necessary to  
reformat the numbers, it will 
make  
viewing them much easier. 
 
 
 
 
 
 
 
 
 
 
 
 
The completed screen will 
appear like this.  

 
 

7. Click the Apply 
Transformation  
button on the toolbar. 
 
This will cause all 
transformations  
to be recalculated. 
 

 
8. Click the Sheet1 tab. 
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The final result appears like this. 

 
Notice the new column of data  
in the Percent variable’s column. 
 
By clicking on a cell, you can see  
that the data is actually stored in  
double precision. 

 

 
 
 

If you change or add data to either Body_Weight or Brain_Weight, the Percent 
variable’s values will not be automatically recalculated. You must recalculate the 
database using the Apply Transformation button or the Recalc All option of the Data 
menu. 

Also remember that these changes are not automatically saved on your hard disk. If you 
want a permanent copy of a database with new transformations, you must save this 
modified version of the database using the Save option of the File menu in the Data 
window. 

Recoding a Variable 
It is often necessary to recode the values of a variable. As an example, we will recode the body 
weights to form a new variable as follows. Animals with a body weight less than 100 kg will 
receive a value of 1. Animals with a body weight greater than or equal to 100 kg will receive a 
value of 2. The transformation formula that will accomplish this is (Body_Weight>=100)+1. The 
expression inside the parentheses results in a “1” if it is true or “0” if it is false. We will call the 
new variable SizeGroup.  

 
1. Click the Variable Info tab. 

 

 

 

 

 
2. Click the C5 name. 
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3. Type SizeGroup and press Enter. 

4. Click in the cell in 
the fifth row and 
third column.  

 

 

5. Type 
(Body_Weight>=100)+1 
and press Enter. 
 

 
 

6. Press the Apply 
Transformations button 
to generate the new 
values. 

  

 

7. Click on the Sheet1 tab to 
return to the data. 

 

 

 

 

The final result appears like 
this. 
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Saving the Changes 
It is important to save changes to your database. Take the following steps to do this. 

 
1. Choose Save from the File menu of the Data 

window. 

 

 

 

 

 

 

 

 

 

 
2. Click Yes. 

The MAMMALS database on your hard disk 
will be replaced with the revised edition. 
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Chapter 4 

Running 
Descriptive 
Statistics 
About This Chapter (Time: 8 minutes) 
This chapter continues the introduction to the NCSS system by taking you through an example of 
using NCSS to obtain descriptive statistics.  

Running Descriptive Statistics 
In this section, you will generate descriptive statistics (mean, standard deviation, etc.) on the 
Body_Weight variable in the MAMMALS data. To begin, start NCSS and load the MAMMALS 
database. Detailed instructions for doing this are at the beginning of Chapter 3. After the database 
is loaded, follow these steps to run the procedure: 

 
1. Click on the Analysis menu. 

From the Descriptive Statistics menu,  
select Descriptive Statistics. 
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The Descriptive Statistics window 
will appear. 

The next step is to select the 
variables to be analyzed. 

 

2. Double click in the Variables box 
or click the small button to the 
right of this box. 

 

 This will cause the Variables 
window to appear. 

 

 

 
  

3. Click on Body_Weight in the Variable 
Selection List box. 

 The variable will appear in the Variables 
Selected box. 

4. Click Ok. 

 
 

 

 

 

 

 

The procedure window reappears. 
Note that the Variables option now has 
a value of Body_Weight. This is the 
name of the variable that was 
selected. 

 
5. Press the Run button to run the 

procedure and generate the following 
output report. 
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The results are displayed in NCSS’s 
word processor. 

You can scroll through the output 
using the scroll bars. You can 
enlarge this window by double-
clicking the title bar--the bar at the 
top containing the words NCSS: 
Descriptive Statistics Output. 

 

 

 

Don’t be intimidated by the 
amount of output. The default 
descriptive statistics report 
contains much more information 
than would normally be used. 
You can generate only those 
reports you want by making 
appropriate selections on the 
Reports panel of the Descriptive 
Statistics window.  

 

 

We will now show how to view 
the graphics in more detail. 

 

6. Scroll down through the output 
until reach the histogram. 

7. Double-click the histogram to 
obtain a full-screen version of 
the histogram. 

 

 

8. After viewing the graph, close it by clicking 
the close button.  
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Saving the Output 
We will now show you how to save the output so that it can be imported into your word 
processor. 

 
1. Select Save As from the File 

menu of the Output window. 

 

 
 

 

 

 

 

 This will bring up the Save File 
As dialog box. 

 Switch the current directory to 
the Report subdirectory, which 
is provided as a convenient 
place to save your reports. 

 

 

 

 

 

 

2. Type myreport.rtf in the File 
name box. 

3. Click Save to save the report. 

 

 

 

 

 

 

 

Note that the three-character extension “rtf” is very important. RTF stands for rich text format. 
Other programs, such as Microsoft Word and WordPerfect, recognize files with this extension as 
importable. Hence, using this extension makes sure that other programs will be able to import 
your report files. 

As an exercise, run your word processor and load the myreport.rtf file. 
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Printing the Output 
We will now show you how to print the output. 

 
1. Select Print from the File 

menu. 

 

 
 This will bring up the Print 

dialog box. 

 

 

 

 

 

 

 

  

 

You can select which pages 
you want to print. 

2. Click OK to begin printing. 
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Chapter 5 

Running a Two-
Sample T-Test 
About This Chapter (Time: 6 minutes) 
This chapter continues the introduction to the NCSS system by taking you through an example of 
using NCSS to run a two-sample t-test.  

Running a Two-Sample T-Test 
In this section, you will conduct a two-sample t-test on data in the MAMMALS1 database. To 
begin, start NCSS and load the MAMMALS1 database (be careful to load MAMMALS1, not 
MAMMALS). Detailed instructions for loading a file are at the beginning of Chapter 3.  

Remember to load the database from the Data window. 

In this example, we will compare the average percent brain weight of small mammals (those 
under 100 kg in weight) to the same average for large mammals. That is, the response variable 
will be Percent and the grouping variable will be SizeGroup. 

 

 

 

 

 

 

 

 

 

 

 

After the database is loaded, follow these steps to run the procedure: 
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1. From the T-Tests submenu of 
the Analysis menu, select T-
Test - Two-Sample. 

 

 

 

 

 

 
 The Two Sample Tests 

procedure window will appear. 

 

 

 

 
2. Double click in the Response 

Variables box. 
 

 

 This will cause the Response 
Variables selection window to 
appear. 
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3. Click on the Percent item in the 
Variable Selection List box. 

 
4. Click Ok. 

 

 

 

 
 

 

 

 

 
 The Response Variables now has 

the entry Percent. This is the 
variable that was selected. 

 

 

5. Double click the top Group 
Variable box. 

 This is the grouping variable. The 
average percent of those rows with 
a SizeGroup value of 1 (small 
animals) will be compared with the 
average percent of those rows with 
a SizeGroup value of 2 (large 
animals). 
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6. Select SizeGroup from the 
list of available variables. 

 

7. Click Ok. 

 

 

 

 

 

 

 

 

 

 

 

 

8. Click the Run button to run 
the analysis. 
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The results are displayed in NCSS’s word processor. 

The T-Test compares the mean percent of two groups. Often, all you will need is the t-value and 
associated probability level. These are contained in the Equal-Variance T-Test Section. In this 
case the T-value is 3.6560 and the probability level is 0.002904. Hence we reject the null 
hypothesis that means are equal. 

A quick glance at the means of the two groups shows that the mean percent for small animals is 
1.03 and for large animals is 0.13. Hence the two percentages are an order of magnitude apart! 

The T-Test chapter of the User’s Guide goes into much more detail on how to perform a T-Test 
analysis. 

At this point, you could save or print the t-test report. 
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Chapter 6 

Running a 
Regression 
Analysis 
About This Chapter (Time: 10 minutes) 
This chapter continues the introduction to the NCSS system by taking you through an example of 
regression analysis. Regression techniques analyze the relationship between a dependent (Y) 
variable and one or more independent (X) variables. NCSS has regression procedures for many 
different situations.  

Running a Regression Analysis 
In this section, you will conduct a regression analysis using the MAMMALS1 database. To 
begin, start NCSS and load the MAMMALS1 database. Detailed instructions for loading a 
database are at the beginning of Chapter 3.  

In this example we will investigate the relationship between Brain_Weight (dependent variable) 
and Body_Weight (independent variable). 
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Creating a Scatter Plot 
The first step in a regression analysis is to plot the data. 

 
1. From the Graphics menu, select Scatter Plots. 

 
 The Scatter Plot window will appear. 

 
  

 

 

 

 

 

2. Click in the Vertical Variable(s) box. 

3. Enter Brain_Weight. 
4. Click in the Horizontal Variable(s) box. 

5. Enter Body_Weight. 

 
6. Click the Run button on the toolbar. 

 

 

 

 

 

 

 
 The scatter plot shown at the right will 

appear. In order for regression analysis to 
be applied, the points in the plot should fall 
along an imaginary straight line.  

 

 While studying the plot, notice that all but two of 
the points are clustered in the lower left-hand 
corner. You cannot tell whether the points fall 
along a straight line. This suggests that a 
logarithmic scale should be used to display the 
data. This will be done next. 
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7. Press the Axes tab to display 
the Axes panel. 

 

 

 

 
8. Select Yes: Numbers from the 

Log Scale pull-down list box 
for the vertical axis. 

 

 
9. Select Yes: Numbers from the 

Log Scale pull-down list box 
for the horizontal axis. 

 

 

 

 
10. Press the Run button to run 

the program and generate the 
following output. 

 

 
 The final result is the plot at 

the right. Notice that the 
points now appear to be 
evenly spread across the plot. 
Also note that the points 
appear to fall along an 
upward-sloping straight line. 
This implies that a standard 
regression analysis should 
produce a reasonable model 
of this data. 

Because of the visual results 
from using the logarithmic 
scale, our next task will be to 
create logarithmic versions of 
the two variables. 
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Create the Logarithmic Variables 
 

1. Press the Data Window button on 
the toolbar to bring the NCSS Data 
window to the front of your screen. 

 
 This will bring up the NCSS 

Data window. 

 

 
2. Click on the Variable Info tab. 

 

This will bring up the Variable 
Info screen.  

 
3. In the sixth row of the 

Transformation column enter 
Log(Body_Weight). 

4. In the seventh row of the 
Transformation column enter 
Log(Brain_Weight). 

5. In the sixth row of the Name 
column enter LogBody. 

6. In the seventh row of the Name  
column enter LogBrain. 

 

7. Click on the Apply 
Transformations button to create 
the transformed data. 

 

8. Click on the 
Sheet1 tab to 
return to your 
data. The 
datasheet will 
now appear as 
shown. 
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Run the Regression 
 

1. Select Linear Regression and Correlation 
from the Regression / Correlation submenu 
of the Analysis menu. 

 

 

 

 

 

 

 

 

 

 

 
2. Click on the Variables tab.  
 
3. Enter LogBrain for the Y: 

Dependent Variable. 

4. Enter LogBody for the X: 
Independent Variable. 

5. Click on the Reports tab. 

  

 

 
 

 

6. Under ‘Select a Group of 
Reports and Plots’, select 
Display items appropriate for 
a STANDARD ANALYSIS. 

 

7. Click the Run button on the 
toolbar. 

 

 This will generate the output that follows. 
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The main statistics of interest in a regression analysis are the R-Squared and the regression 
coefficients. The R-Squared is shown in the Run Summary Section: 

 

 

 

 

 

 

 

 
 

 

The regression coefficients are shown in the Run Estimation Section. 

 

 

 

 

 

 

 

 

 
 

 

The residual plot is found at the bottom of the output: 

 

  

 

 

 

 

 

 

 
 

Of course, a complete regression analysis would require the studying of several reports and plots. 
A complete discussion of this is found in the regression chapters of the User’s Guide.  
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Chapter 7 Chapter 7 

Data Window Data Window 
About This Chapter About This Chapter 
Data may be entered manually or imported from other files. The data are loaded in a spreadsheet 
from which they may be viewed, changed, stored, or printed. This chapter will show you how to 
manipulate your data using the spreadsheet. 

Loading a Database 
The tutorial in Chapter 2 explained the mechanics of entering, storing, and printing a database, so 
that material will not be repeated here. Instead, this chapter will focus on manipulating the data 
with the spreadsheet after it has been loaded. Our first task will be to load in a previously saved 
database.  

If NCSS is not already running, start it now by selecting NCSS from the Windows Start menu 
(refer to the beginning of Chapter 2 for details). We will use the brain weight data that was 
entered in Chapter 2. These data are stored in the MAMMALS database in the 
\NCSS2007\DATA subdirectory. To begin this tutorial, take the following steps to load the 
MAMMALS database. 
 
 
1. Select Open from the File menu of 

the Data window. The File Open 
window will appear. 
 
 
 
 

2. Double click the Data subdirectory 
to select it. 

 
3. Double click MAMMALS.S0 in the 

list of available files. 
 
4. Click the Open button. 
 
 

This will load the MAMMALS 
database into the Data window. 
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The Data window will 
appear as shown to the 
right. 

 

 

 

 

 

 

 

 

 

 

 

 

 

We next examine how to copy and paste data in the spreadsheet. 

Copying and Pasting Data 
We will now take you through the steps to copy and paste the data. 

 
1. Position the cursor in row 

one column three (at the 
value 5712). 

 

 

 

 
 
 
2. Drag the mouse down to 

row six. This will select the 
first six rows. 

 

3. Press Ctrl-C. This will copy 
the data to a temporary 
storage area called the 
clipboard. 
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4. Position the cursor in the 
cell at row one and column 
four. 

 

 

 

 

 

5. Press Ctrl-V to paste the 
data from the clipboard. 
The resulting screen will 
appear as shown. 

 

 

 

Changing Column Widths 
Occasionally, you will want to change the width of one or more columns. This section will show 
you how this is accomplished. We will resize the columns headed Body_Weight and 
Brain_Weight. 

 
1. Click on the column 

heading: Body_Weight. 

 

 

 

 

 

2. Drag the mouse into the 
next column to the right and 
let go of the mouse button. 
This will select these two 
columns. 
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3. Move the cursor between 
the third and fourth 
columns. The cursor will 
change into a double-
pointing arrow. 

 

 

 

4. While holding down on the 
mouse button, drag it to the 
left until you are almost to 
the next cell border. 

5. Let go of the mouse button. 

 

 

 

The resulting display will 
appear like this. 

 

6. Reverse this process to 
reset these columns to their 
original width. 
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Chapter 8 

Procedure 
Window 
About This Chapter 
All NCSS procedures (e.g., T-Test, Multiple Regression, and Scatterplot) are controlled by a 
procedure window. The Procedure window contains all the settings, options, and parameters that 
control a particular procedure. These options are separated into groups called panels. A particular 
panel is viewed by pressing the corresponding panel tab that appears just below the toolbar near 
the top of the window.  

The current values of all options available for a procedure are referred to as a template. By 
creating and saving template files, you can tailor each procedure to your own specific needs.  

Below is a picture of the Descriptive Statistics procedure window. This chapter presents a brief 
tutorial of how to operate the Procedure window. 

Navigating a Procedure Window 
This section will show you how to move around a procedure window. The window is made up of 
two or more panels (in this example there are five panels: Variables, Reports, Probability Plot, 
Histogram, and Template). You control a procedure by changing the settings on each of these 
panels. Hence, navigating a procedure window simply means that you move from panel to panel.  

 
1. From the Analysis 

menu, select 
Descriptive Statistics, then 
Descriptive Statistics. 

 

 The Descriptive Statistics 
procedure window will 
appear. 

 

2. Press the Probability Plot 
tab to display the Probability 
Plot panel. 
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3. Press the Variables tab to 
redisplay the Variables tab. 

 

 

 

 

 

 

 

 

 

 

 

 Notice that many of the 
option boxes have small 
buttons on their right. These 
buttons may be used to 
activate a separate input 
window. For example, if you 
press the button to the right 
of the Variables box, the 
Variable Selection window 
will appear. This window will 
help you select the variables 
to be used. 
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Changing an Option 
Suppose you want to change the Exponent option from None to 3.  

 
1. Press the drop-down button 

on the right of the Exponent 
box. 

 This will activate the drop-
down menu. 

 

2. Move the scroll bar thumb 
down until the 3.0 appears. 

 

  

 

 

 
 

3. Move the cursor down so 
that the 3.0 is highlighted. 

4. Select the 3.0 by clicking it 
(or by pressing the Enter key 
while the 3.0 is highlighted).  

Another way to change this 
option is to select it and 
press 3. The program 
searches through the options 
for the first item that begins 
with a 3. 
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Notes on Modifying Options 
Many of the option boxes have alternative methods of entering data. For example, when you need 
to select a variable, you can type the variable name directly in the box or you can double click on 
the box to bring up a variable selection window. 

Entering Text 
When an option needs text (such as the title of a graph), type the text directly into the box. Note 
that while you are typing, if you decide to revert back to the original text, you can hit the Escape 
(Esc) key. 

Selecting Variables 
When you need to specify variables, you can type their names directly into the box, you can enter 
their numbers directly into the box, or you can activate the variable selection window. 

 

1. Double click in the Variables 
box. 

This will display the variable 
selection window. You can 
select the variables of interest 
and press the Ok button when 
you are finished.  

 

 

 

 

 

 

 

Press the Ctrl key when you want 
to select several, noncontiguous, 
variables. 

As you select variables in the 
Variable Selection List box, they 
will appear in the Variables 
Selected box at the bottom. 

It may be convenient to specify 
variables by number rather than 
by name. For example, when you 
use numbers, you can use the 
same settings on several 
databases, even though the 
variables have different names. 
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Saving a Template 
Once you have filled out a procedure, you may want to save your choices so that you do not have 
to reset them again the next time you use the procedure. This is accomplished using the Template 
panel. 

In this example, we will save the current settings to a file called TUTOR1.  

 
1. Press the Template tab to 

display the Template panel. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2. Enter Tutor1 in the File Name 

box. This is the name where 
the template is stored. 

 
3. Enter an identifying phrase in 

the Template Id box at the 
bottom of the screen. 

 
4. Press the Save Template 

button to store the template 
file. 

 
 
 
 
 
 
 
 
 
 

When you supply the template file name, you do not enter a three-character extension. 
NCSS adds the appropriate extension. This extension may be determined by looking at 
the Template Directory. In this example, the extension is the number 24. You can delete 
these files using your Windows Explorer program. 
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Loading a Template File 
In this example, we will load the previously saved Tutor1 template file.  

 
1. Select TUTOR1 from the 

available template files. 
 
2. Press the Load Template 

button. 
 
 
 The settings are reset to 

how they were when 
Tutor1 was saved. 

 
 
 
 
 
 
 
 
 
 
 

The Default Template 
Whenever you close a procedure window, the current settings are saved in a template file named 
Default. When a procedure is loaded, NCSS checks to determine if the template file Default 
exists. If such a file exists, it is automatically loaded after the procedure window is loaded. 
Hence, the current settings of each procedure window are preserved between sessions. Because of 
this, you should avoid using Default as a template file name. 
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Chapter 9 

Output Window 
About This Chapter 
NCSS sends all statistics and graphics output to its built-in word processor. In the word 
processor, the output can be viewed, edited, printed, or saved. Reports and graphs are saved in 
rich text format (RTF). Since RTF is a standard Windows document transfer format, these files 
may be loaded directly into your word processor for further processing. You can also cut data 
from the report and paste it into an NCSS datasheet for further analysis. This chapter covers the 
basics of our built-in word processor. 

This chapter will continue the analysis of the brain weight data that was begun in Chapter 3. If 
you have not already done so, run the Descriptive Statistics reports as described in Chapter 4. Our 
analysis here will pick up where that chapter ended. 

Viewing the Output 
The output of the Descriptive Statistics program is shown below. Usually, you will find it useful 
to put the output window into full-screen mode.  

 
1. Double click on the Output 

title bar. 

 This will put the word 
processor into full-screen 
mode. 

 

2. Double click on the 
document title bar.  

 This will put the document 
in full-screen mode also. 
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The screen will look similar to 
this. Note that the actual size of 
your screen depends on the 
resolution of your monitor, so it 
will vary. 

 
 
 
 
 
 
 
 
 
 
 
 

3. Select Show All from the 
View menu. 

 
 

 

 

 

 

 

 

 

The screen will look 
similar to this. 

Notice the standard 
word processing ruler, 
tab bar, and button bar. 
These will aid you in 
editing your document. 
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We will now show you a quick way to move about a lengthy document such as the current one. 

 
1. Select Goto Section from 

the Edit menu. 
 This will load the Topic 

Search window.  

 

 

 

 

 

 

2. Select Skewness and Kurtosis 
Section. 

3. Press OK. 

 

 

 

 
 

 

This will position the report so 
that the desired section title is 
showing. 

 

 

 

 

 

 

 

At this point, you would scroll down through your output, perusing the results. Once you 
determine that you want to retain your results, you have four choices: 

1. Print the document. 

2. Save the document to a file. 

3. Add the document to the log. (The log holds the output from several analyses in one file.) 

4. Copy the report to a temporary holding area (the Windows clipboard) and paste it into 
another application. 
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Note that you cannot just leave the output in the current window if you want to keep it because it 
will be replaced by the next analysis that is run. 

Printing the Output 
Before printing the report, you should scroll through it to determine if there are any portions that 
you want to delete before printing. To print the report, take the following steps.  

 
1. Select Print from 

the File menu. 
 This will bring up 

the Print Dialog 
box.  

 
 
 
 
 
 
 
 
 
 
2. Click OK to begin printing your 

report. 

 
 
 This dialog box may appear 

different in different versions of 
Windows. However, the basic 
functionality will be the same. 
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Saving the Output to a File 
You can save the output to a file. The report is saved in rich text format (RTF) which is a 
standard document interchange format. This format may be read into commercial word 
processors such as Word and Word Perfect. This will allow you to export the reports to your 
favorite word processor. 

Take the following steps to save the output to a file. 

 
1. Select Save As from 

the File menu. 
 This will bring up the 

Save File As dialog box. 
Note that this dialog box 
may look different in 
Windows 95, but the 
basic functionality will 
be the same. 

 
 
 
 
 
 
 
2. Enter a file name such as 

MyReport.rtf. 

 Note that the file name must 
end with the extension “rtf.” 

 

3. Click Save to save your 
report. 
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Saving the Output to the Log 
An analysis of a set of data usually requires the running of several statistical procedures. The log 
document provides a convenient way to store the output from several procedures together in one 
file. When you have a report or graph you want to keep, copy it from the output document to the 
log document. 

The log document provides four main word processing functions: loading, editing, printing, and 
saving. When you load a file into the log document, you can add new output to it. In this way, 
you can record your work on a project in a single file, even though your work on that project is 
may be spread out over a large time period. 

Take the following steps to add the current output to the log document. 

 
1. Select Add Output to 

Log from the File menu. 

 
 This will copy the current 

document to the log file. 
  
 To view the log 

document, select Log 
from the Window menu. 

 
 
 
 
 
 
The log document resides in memory until you store it. To store the log document, take the 
following steps: 
 
1. Select Log from the Window menu so that the log document is active. 

2. Select Save As from the File menu and complete the Save File As dialog. 

 
Warning: The log document is not automatically stored. You must store the contents of 
the log document to a file before exiting NCSS. 
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Chapter 10 

Filters 
About This Chapter 
This chapter explains how to use filters to limit which rows (observations) are used by a 
particular procedure and which are skipped. For example, you might want to limit an analysis to 
those weighing over 200 pounds. You would use a filter to accomplish this. 

Setting Up a Filter 
Using the MAMMALS database (see Chapter 3), we will setup up a filter so that only those 
animals with a body weight greater than 200 kilograms are used in the statistical calculations.  

If the MAMMALS database is not currently loaded, select Open from the File menu, move to the 
\NCSS2007\DATA subdirectory, and double click on the file MAMMALS.S0. Your display 
should appear as follows. 

 
1. Select Filter from the Data menu. 

 
This brings up the Filter template. 
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2. Check the Filter System 
Active box. 

 

 

 

 

 

 

 

 

 

 

 

 
3.  Enter the filter condition, 

Body_Weight>200, in the 
Filter Statements box. 
 

 

 

 

 
4. Press the Run button to  

activate the filter. 
 

 

 

 

 
5. The Filter activated box will be 

displayed. You may press Close, or the 
message will automatically disappear. 
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The filter is now setup. Notice 
that the Filter button on the 
both the Data and Filter 
toolbars has now changed to a 
green funnel with a yellow 
background and the word ON 
below it. This is a reminder 
that the filter system is active. 

 

 

 

 

 

 

 

Using a Filter 
We will now show you how to use it in a procedure by obtaining the mean and standard deviation 
of the filtered database. 

 
1. Open the Descriptive Statistics 

procedure by going to Analysis, 
Descriptive Statistics, Descriptive 
Statistics. 
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2. Enter Body_Weight in the 
Variables box. 

 
 
 
3. Press the Run button to run the 

procedure. 
 
 
 
 
 
 
 
 
 
 
 
 
4. Finally, view 

the output.   
 

Notice that 
although 
fifteen rows 
were 
processed, 
only six rows 
were actually 
used in the 
computations. 

 

 

 

 

 

Disabling the Filter 
When you are finished using a filter, you can bring up the Filter procedure window, click the 
Filter System Active button so that it is not checked, and press the Run button to run the filter 
procedure. This will deactivate the filter.  
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Chapter 11 

Writing 
Transformations 
About This Chapter 
The basics of entering transformations were covered in Chapter 3. This chapter gives examples of 
how to write more advanced transformations. 

Recoding 
Data recoding refers to replacing one set of values with another. For example, suppose you have 
each individual’s age stored in a variable called AGE. Suppose that you want to create a new 
variable called AGEGROUP that classifies each individual into one of four age groups according 
to the following rule: 
 

AGE Values AGEGROUP Value 
1 to 12 1 
13 to 19 2 
20 to 29 3 
30 and above 4 
 

Example of Recode 
RECODE(Age;  (1:12 = 1) (13:19 = 2) (20:29 = 3) (Else = 4)) 

Notice the basic syntax of this function. The variable being recoded is given first (here Age). 
Next, a set of statements that define the recoding are given. 

Example Results 
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Basic Indicator  
Indicator transformations are used in logic (if - then) situations. An indicator function evaluates 
to one if the condition is true, or to zero if the condition is false. The basic syntax is two 
arguments between parentheses separated by a logic operator. The possible logic operators are <, 
>, <=, >=, <>, and =. 

Example of Indicator 
 (AGE > 20) 

If AGE is greater than 20, the result will be a one. Otherwise, the result will be a zero. 

Example Results 
 

 

 

 

 

 

 

Compound Indicators 
Since indicator functions evaluate to a numeric value (either 0 or 1), they may be combined with 
other functions, including other indicator functions. When combining several indicators, the 
logical AND is achieved by multiplying the indicators and the logical OR is achieved by adding. 

Example of Compound Indicator 
 (AGE > 20)*(AGE<=40) 

If age is greater than 20 and less than or equal to 40, the result will be a one. Otherwise, the result 
will be a zero. 

Example Results 
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Using Indicators for If – Then Transformations 
Indicator functions may be used in place of if - then statements. The following examples show 
how this is done.  

Example 1 of If-Then Indicator 
If Age is less than 20 set AdjIncome to 5000. Otherwise, set AdjIncome equal to Income. 
 (Age < 20)*5000+(Age>=20)*Income 

Note that the indicator functions used here are opposites. When (Age<20) is 0, (Age>=20) will be 
equal to 1. 

Example 1 Results 
 

 

 

 

 

 

 

 

It may be helpful to look at how this expression works on the first two rows.  

Calculation for the first row: 

(23<20)*5000+(23>=20)*22000 = 0(5000) + 1(22000) = 22000 

Calculation for the second row: 

(15<20)*5000+(15>=20)*22000 = 1(5000) + 0(5500) = 5000 

Example 2 
If Age is less than 20 set AdjIncome equal to Income + 1000. Otherwise, set AdjIncome to 
Income + 2000. 
 (Age < 20)*(Income+1000)+(Age>=20)*(Income+2000) 

Example 2 Results 
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It may be helpful to look at how this expression works on the first two rows.  

Calculation for the first row: 

(23<20)*(22000+1000)+(23>=20)*(22000+2000) = 0(23000) + 1(24000) = 24000 

Calculation for the second row: 

(15<20)*(5500+1000)+(15>=20)*(5500+2000) = 1(6500) + 0(7500) = 6500 
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Chapter 12 Chapter 12 

Importing Data Importing Data 
About This Chapter About This Chapter 
This chapter presents an example of importing data from a comma delimited ASCII (text) file 
into NCSS. 

The ASCII File 
Following is a set of data contained in the file ASCII.TXT in your \DATA subdirectory. We will 
now go through the steps necessary to import the data from this file. 

Bob,2,4,22,5 
Judy,5,44,22,4 
Sam,1,32,42,9 
Mary,4,1,22,23 
John,19,22,44,1 
Linda,3,11,2,14 

How to Import ASCII.TXT 
 
1. Press the New Database 

button on the toolbar. 

 It is necessary to clear the 
previous database. 
Otherwise, the imported 
data would be added to it.  

 

 A dialog box, entitled 
Create a New Data File, 
will appear. 
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2. Indicate that you want a 
Spreadsheet-type data file 
since this is a small set of 
data. 

 

 Since this is the default, just 
click OK. 

 

 

 

 

3. Select Import from the 
File menu. 

 

 

 

 

4. Select ASCII Delimited 
*.TXT from the Select the 
File Type selection box. 

 

 

 

 

 

 

 

 

 

 

 

5. Press the Select a File to 
Import button to specify 
the file name. 
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6. Click on the Ascii.txt in the 
Data directory to specify the 
desired file. 

 

 

 

 

7. Press the Open button to 
finish selecting the file. 

  

 

 

8. Press the Next button 
to move on to the next 
import screen. 

 

 

 

 

 

 

 

  

 
 

9. Since the correct 
delimiter (a comma) is 
specified, you are ready 
to continue. Press the 
Next button to move on 
to the next import screen. 
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10. Since we want to import 
all the data, we leave all 
the variables C1 – C5 
selected. Click the 
Finish button to begin 
the import. 

  

 

 

 

 

 

 

 

The imported data will appear in the Data window. 

 
 

Note that the imported database resides in your computer’s memory, not on the hard 
disk. If you want to make a permanent copy of your data, you should select Save As 
from the File menu and save a copy of the imported data to your hard disk. 
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Chapter 13 

Value Labels 
About This Chapter 
Value Labels provide a mechanism to attach labels to coded data. For example, in a questionnaire 
you might have questions whose responses fall along a Likert scale. Perhaps you have entered the 
data as numeric values from 1 to 5. Value labels may be attached to the responses so that 1 shows 
up on your printout as “Strongly Agree” and 5 is displayed as “Strongly Disagree.”  

This chapter will provide you with a step by step outline of how to use value labels. The data for 
this example come from a four-item questionnaire that was given to twenty people as part of a 
political poll. The first three questions contain demographic information about the individual. The 
fourth question is their opinion about a hot political issue. You will find these data in the 
POLITIC database. The data were coded numerically for easy data entry as follows: 

POLITIC Database 
AgeGroup 
 1 = 25 and under 
 2 = 26 to 34 
 3 = 35 to 55 
 4 = 56 and above 

State 
 1 = California 
 2 = Virginia 
 3 = Texas 
 4 = Other 

Party 
 1 = Democrat 
 2 = Republican 
 3 = Other 

Issue 
 1 = Strongly agree 
 2 = Agree 
 3 = Neutral 
 4 = Disagree 
 5 = Strongly disagree 
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Adding the Value Labels 
The next step is to add the value labels to the database. This is done by entering the values and 
corresponding labels in adjacent columns of the database. Leaving space for additional response 
variables, we put the value labels in columns 15 through 22. C15 contains the values of 
AgeGroup, C17 contains the values of State, and so on. 

Note that we have resized the column widths to make the display easier to read (C15, C17, C19, 
and C21 are narrower than usual). 

Although in this example we are constructing value labels for each variable, you do not have to 
do this. You can label as many or as few variables as you like. 
 

 
 

Attaching the Value Labels to the Variables 
The final step is to attach the value-label columns to the appropriate variables. This is 
accomplished as follows: 

 
1. Click the Variable Info 

tab. 

 

 

 

 

 
2. Use the vertical scroll 

bar or the Page Up 
key to reposition the 
view to the top of the 
Variable Info 
datasheet. 

 

3. Click in the first cell 
under Value Labels to 
set the spreadsheet 
cursor there. 
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4. Type C15. 
 Press Enter. 
 Type C17. 
 Press Enter. 
 Type C19. 
 Press Enter. 
 Type C21. 
 Press Enter. 

 This attaches each 
value label column 
to the appropriate 
variable. Note that 
you may use the 
same value label 
variable more than  
once. 

Using the Value Labels in a Report 
We will now show you how the value labels change the output of the Frequency Table procedure. 

 
1. Select Frequency 

Tables from the 
Descriptive Statistics 
menu. 
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2. Enter AgeGroup-
Issue as the Discrete 
Variables. 

 

3. Run the procedure by 
pressing the Run 
button. 

 

 

 

 

 

 

 

 

 

The output appears 
as shown. 

Notice that the value 
labels have not been 
used. 
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4. Select the Format 
tab to display the 
Format panel. 

 
5. Select Both in the 

Value Labels box. 

 

6. Run the analysis 
again by pressing 
the Run button. 

 

 

 

 

 

 
The output window 
appears as shown.  

Note that the value 
labels are now 
displayed. 
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Chapter 14 Chapter 14 

Database Subsets Database Subsets 
About This Chapter About This Chapter 
It is often useful to store all of your data in one large database and then analyze various subsets of 
the database as necessary. This can often be accomplished using the Filter mechanism. 
Sometimes you will find it more convenient to create a subset of the original database that only 
contains those rows that you want to analyze. 

This chapter will take you through the steps necessary to create a subset of the POLITIC database 
(described in Chapter 13) that contains only those individuals with AgeGroup equal to 2 (26 to 
34). 

Creating a Database Subset 
Use the following steps to create a database subset. If you have not already done so, open the 
POLITIC database now by selecting Open from the File menu of the Data window. 

Step 1 – Sort the Database 
The first step is to sort the POLITIC database by the variable (or variables) that you want to 
subset on. This is done as follows. 

 
1. Select Sort from the Data 

menu. 
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2. Select AgeGroup as 
the variable to sort the 
database by. This m
be done by using the 
drop-down menu or by
double clicking. 

ay 

 

 
3. Click Ok to sort the 

database by the 
selected variable. 

 

 

 

Step 2 – Copy Subset into New Database 
The next step is copy the selected data from the POLITIC database to the new database (which 
will be named POLITIC2). 

 
The database will be sorted by 
AgeGroup. 

1. Select the desired subset by 
dragging the mouse from 
row 5 of column 1 
(AgeGroup) to row 11 of 
column 4 (Issue). Your 
selection should appear as 
shown. 

 

2. Press Ctrl-C to copy the 
selected data to the 
Windows clipboard (the 
clipboard is the name of 
temporary holding area used 
by Windows to store 
information that has been cut 
or copied). 

 

3. Select New from the File 
menu to create the subset 
database. 
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4. Select No from the  
message box that  
appears and asks if 
you want to save  
changes.  
 

 

It is important not to save the sorted database because the value labels have also been 
sorted – something we do not want in this case. 
 
 

5. Click Ok to create a 
spreadsheet type 
database. 

 

 

 

 

 

 

6. Position the cursor 
in the upper left cell 
of the new 
database by 
clicking in it. 

 

 

 

7. Press Ctrl-V to 
paste the clipboard 
data into the new 
database. 
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8. Select Save As from 
the File menu to 
name and save this 
new database. 

 

 

 

 

 

 

 

9. Enter Politic2.s0 
as the name of the 
new database.  

 Click Save. 

 

 

 

 

 

 

 

 

Step 3 – Copy Variable Info to New Database 
The next step is to copy the variable information datasheet to the new database. 

 
1. Open the POLITIC 

database by 
selecting it from the 
File menu. 
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2. Click on the Variable 
Info tab to move to the 
Variable Info 
datasheet. 

 

 

 

 

3. Select the information to 
be copied by dragging 
the mouse across it. 

 

4. Press Ctrl-C to copy the 
information to the 
clipboard. 

 

5. Open POLITIC2.S0 by 
selecting it from the File 
menu. 

 

 

 

 

 

 

 

 

 

6. Move to the Variable I
datasheet by clicki
Variable Info tab. 

nfo 
ng the 
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7. Position the cell cursor 
over the cell containing 
C1. 

 

8. Press Ctrl-V to paste the 
label information into the 
subset database. 

 

 The result will appear as 
shown. 

 

 

 

 

Step 4 – Copy Value Labels to the New Database 
The final step is to copy the value labels from the old database to the subset database. 

 
1. Open the 

POLITIC.S0 
database by 
selecting it from the 
File menu. 

 

 

 

 

 

 

 

 

 

2. Select Yes to save the 
changes that you  
have just made to  
the POLITIC2  
database. 

 

 



 Quick Start – Database Subsets  14-7 

3. Enter politic2.s0 in the File 
Name field of the Save File 
As dialog box. 

 Click the Save button. 

 When asked, indicate that 
you want to replace the 
previous version of this file. 

 

 

 

 

4.   Reposition the 
datasheet so 
that the first 
column is C15. 
Drag the m
across and 
down so that all 
of the value 
labels are 
selected as 
shown below. 

ouse 

 

5. Press Ctrl-C to copy the selected information to the clipboard. 

 

6. Open the POLITIC2.S0 
database by selecting it 
from the File menu. 

 

 

 

 

 

 

 

 

 

7. Reposition the 
datasheet so 
that variable 
C15 is at the 
left. 
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8. Click in the first row of variable C15 so that this is the active cell. 

9. Press Ctrl-V to copy the information. The final result should appear as below. 

10. Select Save from the File menu to save the database. 

Review 
The following is a review of the steps for creating a database subset: 

1. Sort the database by the variables on which you want to subset. 

2. Copy the subset data to a new database. 

3. Copy the variable info from the old database to the subset database. 

4. Copy value label information (if it exists) from the old database to the subset database. 
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Chapter 15 Chapter 15 

Data Simulation Data Simulation 
About This Chapter About This Chapter 
There are many situations in which you want to generate data that follow a known distribution. 
For example, you may want to generate 100 uniform random numbers as an aid in selecting a 
random sample or you may want to generate five columns of normal random numbers to 
experiment with a particular statistical test. This chapter will show you how to use 
transformations to generate simulated data. 

For transformations, NCSS directly generates two types of random numbers: uniform and normal. 
Other types of random numbers may be generated by using their inverse probability function on a 
set of uniform random numbers. 

NCSS also has the Data Simulator procedure (Chapter 122), in which many more options for 
simulating data of various distributions, including mixture distributions, is discussed. 

Generating Uniform Random Numbers 
In this tutorial you will generate 100 uniform random numbers. 

You should begin this tutorial with an empty database. If your database is not empty, select New 
from the File menu to clear it. 

 
1. Move to the Variable Info 

datasheet by clicking the 
Variable Info tab. 
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2. Enter 100 in the Number of 
Rows box.  

 This specifies the number of 
rows to be generated. 

 
3. Enter Uniform(3) as the 

transformation for variable 
C1. 

 Note that the “3” in the 
parenthesis is ignored. The 
program generates a 
random “seed” so that a 
different set of random 
numbers will be used each 
time you recalculate the 
spreadsheet. 

 
4. Press the Apply Transformation button to generate the random numbers. 

5. Click the Sheet1 tab to view the data. 

 

 The data will appear as 
shown. However, the 
numbers themselves will be 
different since each 
recalculation uses a 
different starting seed. 

6. Press the Apply 
Transformation button a 
few more times to generate 
new sets of random 
numbers. 
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Simulating the T-Test with N = 5 
We will now run a simulation in which we generate 100 one sample t-test values with a sample 
size of five. Four of the values will come from a normal distribution with mean 50 and standard 
deviation 2. The fifth value will come from a normal distribution with mean 50 and standard 
deviation 15. The t-test will test the null hypothesis that the population mean of the sample is 50. 

It will be interesting to study the distribution of these T-values since the T-Test makes the 
assumption that all five data values follow identical distributions. This simulation will allow us to 
study the distortion that occurs when this assumption is not met. 

 
1. Enter 100 for the number 

of rows. 

 

2. Enter the new variable 
names. 

 

3. Enter the transformations. 
Notice that we multiply 
the random normal by the 
standard deviation (2 or 
15) and then add the 
mean (50). 

 

4. Enter 0.0000 as the 
format for each of the 
variables. This will make 
the data much easier to 
read. 

 

5. Move to the empty spreadsheet by clicking Sheet1.  

 



15-4  Quick Start – Data Simulation  

6. Click the Apply 
Transformation 
button to generate 
the simulated data. 
Your results will be 
similar to those 
shown here. 

 If you have made 
an error in entering 
the transformation 
formulas, you will 
have to go back to 
the Variable Info 
datasheet to make 
corrections. 

  

 

There are many ways to analyze the results. One of the easiest is to sort the TValue column and 
count the number of rows whose values are outside the theoretical bounds. If these data had come 
from a normal distribution with a mean of 50 and a standard deviation of 2, you could use the 
Probability Calculator to determine the theoretical cut off values. The two-tail critical value for a 
T distribution with 4 degrees of freedom and alpha = 0.05 is 2.78. Hence, you would expect that 
five of the one hundred values would be less than -2.78 or greater than 2.78.  

Here’s how to sort the data: 
 

 

 

 

 

 

  

1. Select Sort from the Data 
menu. This will bring up 
the Sort window. 

2. Select TValue as the sort 
variable. 

3. Click Ok to perform the 
sort. 

 

4. Scroll from through your data counting how many values are less than -2.78 or greater than 
2.78. 

 

In our case, only one row is outside the range. We repeated this simulation several times and 
never found more than three values outside the range, much less than the five values that the null 
hypothesis predicted. 



  16-1 6-1 

Chapter 16 Chapter 16 

Cross Tabs on 
Summarized Data 
Cross Tabs on 
Summarized Data 
About This Chapter About This Chapter 
This chapter presents an example of how to enter and analyze a contingency table that has already 
been summarized.  

Sample Data 
The following data are the results of a study that tested the impact of three drugs on a certain 
disease. 
 

  Drug 
Disease Type 1 Type 2 Type 3 
 Yes 15 28 44 
 No 4 7 9 
 

These data are entered into an NCSS database as follows. 

 

 

 

 

 

 

 

Notice that we have created three variables: 

1. One containing the column identification number (Drug). 

2. One containing the row identification number (Disease). 

3. One containing the counts (Count). 
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Filling Out the Cross Tabulation Window 
The next step would be to fill out the Cross Tabulation window. This is done as follows. 
 

1. Choose Cross 
Tabulation from the 
Descriptive Statistics 
submenu of the 
Analysis menu. This 
will load the Cross 
Tabulation window. 

2. Enter Drug in the 
Discrete Variables 
box under Table 
Columns heading. 

3. Enter Disease in the 
Discrete Variables 
box under Table 
Rows heading. 

4. Enter Count in the 
Frequency Variable 
box. 

5. Press the Run button 
to run the analysis. 

 

The final result will appear as follows. 
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